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About the Uniscan edB Scanner - Equipment included:

Chapter 1
About the Uniscan e46 Scanner
Equipment included:

Please ensure all the following items are included before installing the
Uniscan e4é6 scanner.

I. Uniscan e46 Scanner

2. Power cord

3. USB Connector
4. Quick guide

5. Installation CD



About the Uniscan ed8 Scanner - Software Instalation

Software Installation

The Uniscan e46 Utility provides a convenient interface for accessing
the advanced scanning functions. With the Uniscan e46 Utility, you
can quickly scan documents or images, make a quick copy of a
document and send it to the printer, scan an image and send it
directly to your email client, scan text documents and edit them with
word processing software, or define a default application to send
your scanned document to for post processing.

CUSTOM  E-MAIL Scan OCR COPY/PRINT

QIE-LI

E wit | Preferences | Help |

The Uniscan e46 Utility interface emulates the control pad on the
scanner, and allows you to control scanner functions from your PC:

06000

The Uniscan e46 Utility interface has five buttons: Scan, OCR, CUSTOM,
Copy/Print and E-mail. Pressing a button scans an item and sends it to
your printer or a specific application, such as your e-mail software.

Each button has a default application pre-selected for post
processing. When you install the scanner, the software checks your
computer for an application that is appropriate for each button (for
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About the Uniscan edB Scanner - Connecting to the Scanner

example, Microsoft Outlook for the E-mail button). If one is found, the
software assigns that application to the button.

If you want to select another application or customize the scan
settings, you can create new configurations or edit existing ones. For
example, if you scan color photos for use on the Web, you can create
a configuration that works best when scanning pictures for use with
HTML.

This scanner uses the USB interface, which is only supported by
Microsoft Windows 98/Me, 2000 or XP.

Plug & Play devices are supported by the USB interface. To verify
whether your computer supports USB, first make sure there is a USB
port at the back of your PC (some computers have USB ports in other
locations, such as on the monitor or keyboard).

If your computer does not have any USB ports, you may need to
install a USB interface card (check your computer User's Manual for
USB support information).

N\

2@

USB Port
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About the Uniscan edB Scanner - Connecting to the Scanner

Starting the Uniscan e46 Utility

After installing the scanner software and drivers and rebooting, the
scanner icon 2% will be displayed in the Windows taskbar:

|<E@% 8:26 PM

Double-clicking the icon opens the Uniscan e46 Utility:

ol | m -

E xit | Freferences | Help |

Note: If you have not connected the scanner to the PC, the scanner
disconnected icon &2 will be displayed. You must establish a
connection before using the Uniscan e46 Utility.

Once you have connected the scanner via USB port, the Utility will

automatically connect to the scanner and display the following

message box:

= Configuring Uniscan ed6 ...

If the connection fails, you will see the following message:

? ILInisu:an ed6 Connect FAILED ...

Please refer to Troubleshooting for more information.

Clicking a button opens the associated application. Click Help to
display online help for the Uniscan e46 Utility. Click Exit to send the
Utility back to the Windows Taskbar. Clicking Preferences enables you
to set preferences for each application.



About the Uniscan edB8 Scanner - The Uniscan ed8 Utility Interface

The Uniscan e46 Utility Interface

The following table describes the function of each button on the
Uniscan e4é Utility interface:

Q Copy/Print Button: Click Q to send a scanned

image or document directly to a printer or printer
application.

<D Fax Button: Click D] fo display your scanned
item in the default fax software.

OCR Button: Click @l to convert a scanned
@ item to black and white text for use with word
processing software.

E-Mail Button: Click to send a scanned

abc image or document directly fo an e-mail
—_— program.
i Custom Button: Click E to send a scanned
_.E image or document directly to a pre-selected
—_— application.
Frefersnces |
Preferences: Click ficteiences | to set preferences for each

button. You can add and choose settings for post processing
applications, set scanner status display options, and set
advanced properties such as image mode, color control and
resolution.

Exit: Click __®__|to send the Uniscan e46

Exit
i Utility back to the Taskbar.
Hel Help: Click ke to display the online help
¢ for the Uniscan e46 Utility.

The next chapter describes how to use each function in detail.



Using the Uniscan ed8 Utility - Scan Function

Chapter 2
Using the Uniscan e46 Utility

This chapter describes each function in detail.

Note: For information regarding the TWAIN Interface, refer to the
TWAIN Interface online help.

Scan Function

Use the Scan function to scan images or documents and send them
fo the TWAIN Interface for image post processing. Follow these
instructions:

1. Place the item face down on the scanner, with the corner of the
paper next to the arrow, as shown:

2. Double-click the Uniscan e46 Utility icon in the Windows taskbar.
The Uniscan e46 Utility will open.

|<H—,@% 8:26 PM




Using the Uniscan ed8 Utility - Scan Function

3. Click the Scan button on the Uniscan e46 Utility. The TWAIN
Interface will open.

@@!@

E st | Freferences | Help |

4. Inthe TWAIN Interface, make any adjustments to the General
Settings and Image Adjust before clicking Scan.

If sending the scanned image to another application after scanning,
you must wait at least ten seconds for the post-processing application
to load.

Note: For information on setting the TWAIN interface opfions, refer to
the TWAIN interface online help.

I Reflective
BER  Colr24tit
@ 200dpi

B NoDescreen
Custam

™ ko Adjust

Note: You can setf the post processing application that the TWAIN
Interface sends the image to. Please refer to the Preferences
section for more information about settings.



Using the Uniscan e48 Uility - Copy,/Print Function

Copy/Print Function

Use the Copy/Print function fo scan images or documents and send
them to the printer.

1. Place the item face down on the scanner, with the corner of the
paper next to the arrow, as shown:

2. In Windows, double-click the Uniscan e46 Utility icon in the
Windows taskbar. The Uniscan e46 Utility will open.

|<EJ-@% 8:26 PM

3. Click the Copy/Print button on the Uniscan e46 Utility interface.

Uniscan edb

@‘B.@

E st | Freferences | Help |




Using the Uniscan e46 Uskility - Copy,/Print Function

4. After the image is scanned, the Print dialog box opens. Note
that you must wait at least ten seconds for the Print dialog box
fo load.

Note: By defaulf, the scanned image is sent directly to the selected
printer without opening the TWAIN Interface.

Printer : 4N TASYHP Lazer)et 4100 PCL &

Copies; |_1:|
— Picture Position
£ Picture i the Center
€ PFicture Full Pags
£ Picture ka5 stretch Cancel

i

€| Ficture in the Upper Left

5. Click Printer to select a printer. A new Print dialog box will open.
Select a printer icon from the menu. Click Print to print out the
scanned image, or click Cancel to return to the Scanner Utility
Print dialog box.



Using the Uniscan e48 Uility - Copy,/Print Function

2lx
General |Finishing| Effectsl Paper I Destinationl Easicsl
— Select Printer
= (= e
Add Printer  HP Laserlet  HP Acrobat Acrobat
2100 Seri... 4100PCLG ... Distiller POFwWriter *
4| 3
Statuz: Ready
Location: : :
: Find Printer... |
Comment;
—Page Range
LOlE| Mumber of copies: |1 3:
€ Selection € Curent Page
) Pages: I [T Callate ! E
L
Cancel

6.

10

Click OK. The document is then sent to your printer.

< emEl(E) eszem



Using the Uniscan ed8 Uktility - Custormn Function

Use the Custom function to scan images and documents and send
them to a user-defined application for post processing.

Note: Before you can use this function you must assign a default
application for post processing.

1. Place the item face down on the scanner, with the corner of the
paper next to the arrow, as shown:

2. Double-click the Uniscan e46 Utility icon in the Windows taskbar.
The Uniscan e46 Utility will open.

|<EJ-$% 8:26 PM

3. Click the Custom button on the Uniscan e46 Utility. The TWAIN
Interface will open.

Oy | m | 2

E xit | Freferences | Help |
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Using the Uniscan ed8 Utility - Custormn Function

4. Inthe TWAIN Interface, make any adjustments to the General
Settings and Image Adjust. Then click Scan.

After the image is scanned, it is sent to the assigned application for
post processing.

Note: For information on setting TWAIN interface options, please
refer to the TWAIN interface online help.

Reflective

Color 24 bit

200dpi

Mo Descreen

Custom

ELLLLLS
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Using the Uniscan ed8 Utility - OCR Function
OCR Function

Use the OCR function to scan images or documents and send them
fo your default word processing application. Follow these
instructions:

1. Place the item face down on the scanner, with the corner of the
paper next to the arrow, as shown:

2. Double-click the Uniscan e46 Utility icon in the Windows taskbar.
The Uniscan e46 Utility will open.

|<EJ-@% 8:26 PM

3. Click the OCR button in the Uniscan e46 Utility. The TWAIN
Interface will open.

QIE.&I

E it | Freferences | Help |

13



Using the Uniscan ed8 Utility - OCR Function

4. Inthe TWAIN Interface, make any adjustments to the General
Seftings and Image Adjust, and then click Scan.

After the image is scanned, you must wait at least ten seconds for the
word processing application to load.

Note: Before you can use this function, you must assign a default
application for post processing. Refer to Preferences for more
information.

el Q51 ) D || Advance |

Reflective

Color 24 bit

200dpi

Mo Descreen

Custom

ELLLLLS
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Using the Uniscan edB8 Utility - E-mail Function

Use the E-mail function fo scan images and documents and send
them to your e-mail program. Follow these instructions:

1. Place the item face down on the scanner, with the corner of the
paper next to the arrow, as shown:

2. Double-click the Uniscan e46 Utility icon in the Windows taskbar.
The Uniscan e46 Utility will open.

|<EJ-@% 8:26 PM

3. Click the E-mail button on the Uniscan e46 Utility. The image will
then be scanned.

Uniscan ed4b

@'Iﬁ%.&l

E it | Freferences | Help |

4. After the image is scanned, it is sent to your default e-mail
program and attached to a blank e-mail, ready o be
addressed and sent. Note that you must wait atf least ten
seconds for the e-mail program to load.

15



Using the Uniscan ed8 Utility - E-mail Function

=101 %]

gt Attached Files

J File Edit Wiew Insert Format Tools Message Help

E‘&i%%n@“&?
[

Send Ut Copy  Faste  Undo Check  Speling

To:
Ce: |
Subject: I.ﬂ.l:l:ached Files

Attach: @Pmnnnnn.JPG {2.33 MB);

A E|® 704

a
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Using the Uniscan edB8 Utility - Preferences

The Preferences dialog box enables you to configure the settings for
each button and assign applications for post processing. Double-
click the scanner icon 22 in the Windows taskbar o open the
Uniscan e46 Utility:

Uniscan e4b

QIE-LI

Exxit | | Preferences ,\1 Help |
L&

Click Preferences to open the Uniscan e46 Utility Preferences dialog
box:

17



Using the Uniscan ed8 Ultility - Function Settings
Function Settings

This section explains how o use the options in the Uniscan e46 Utility
Preferences Function Seftings tab.

Uniscan e46 Utility preferences x|
Function | F'leferencesl

@ Select Menu:
=]

E Select Default Application:

Kaodaklmg

Add Application Remowe Application |
Adv. properties | Rezet to default |
Ok | Cancel | Help |

18



Using the Uniscan edB8 Utility - Select Menu

Select Menu

The Select Menu enables you to choose which button you want to

configure and set preferences for. Choose a button from the drop-
down menu:

Uniscan e46 Utility preferences 1 x|

Function | Freferences I

@ Select Menu;
ﬁ Scan

<D Copy/Frint
[a] Ocr

=¥ card

= Email

@ Custarn

Add Application Remaove Application

Adv, properties Fieset to default

ok Cancel Help

After selecting a button, you can add or remove an application to

be associated with it, set advanced properties, or reset the button
to the default values.

Add Application

Use Add Application to associate an application to a button for post
processing scanned images or documents.

1. Select a button from the drop down list.

19



Using the Uniscan ed8 Uktility - Select Menu

Uniscan e46 Utility preferences

Function | Preferences I

@ Select Menu:

m Scan

<D Copy/Frint
[2] 0

=¥ card

= Email

@ Custarn

Add Application Remove Application

Adv, properties

Reset to default

ok Cancel Help

2.

20

The button’s default application list is displayed:



Using the Uniscan edB8 Utility - Select Menu

Uniscan e46 Utility preferences R x|

Function | Preferences I

@ Select Menu:
IE Scan j

E Select Default Application:

Kadak|mg

Add Application Remove Application
Adv, properties Fieset to default
ok Cancel Help

3. Click Add Application. The Open application dialog box is
displayed:

21|

Look in: Ia Phaotoshop 6.0 j - =k EF-

Help [ 15amples

Helpers ImageReady

Legal EF‘hotoshp

Plug-Ins

Presets

Required
File narne:

J_ Open I
Files of type: | *.exe ;I Cancel |

21



Using the Uniscan ed8 Uktility - Select Menu

4. Browse to the location of the application that you want
associated with the button. Click Open to add the application
fo the default application list:

Uniscan e46 Utility preferences |

Function | Preferences I

@ Select bMenu:
Im Scan j

E Select Default Application:

F.odakimg
PhotoShap 5.0

Add Application | Remove Application |
Adv, properties \g Fesat to default |
ak | Cancel | Help |

5. Select the application and click Adv. Properties. The Properties
dialog box is displayed:

22



Using the Uniscan edB8 Utility - Select Menu

Color Contral

' Calor Image Erightness I 0=
" Gray Image Contrast I Dﬁ
B/ Image Gamma I 1=

— Image Mode

— Resolution

[ Dizable Twain, using autocrop

ak. I Cancel

100 7

The Properties dialog box enables you to set the following items:

» Image Mode: select color, gray, or black & white (B/W) for
output image mode.

»  Color Control: enter the brightness, contrast, and gamma in the
boxes.

» Resolution: select the output resolution from the drop-down
menu. You can select a resolution from 75 to 600 dpi.

Check the box next to Disable TWAIN, using autocrop, to have
images scanned directly to the application without being opened
in the TWAIN dialog first. The image is automatically cropped
before opening in the application.

Click OK to save your changes and return to the Uniscan e4é6 Utility
Preferences dialog box or click Cancel to exit without saving
changes.

To remove an application from the button’s default application list,
select the application and click Remove Application. To return the
button’s application list to the default settings, select the
application and click Reset to default.

23



Using the Uniscan ed8 Utility - Preference Settings

Preference Settings

In the Uniscan e46 Utility Preferences dialog box, click the
Preferences tab to open the following screen:

Uniscan e46 Utility preferences |

r— Display scanner status

Function

" Display Uniscan e4f status message

¥ Show scan progress dialog when Twain is disabled

— Temp folder

IC:kWINNT\twain_32'\e4B\Temp Falder |

Clean temp folder files I

— Smart Scan status
¥ Show all applications for each scanner button

¥ Holding scanner button activates Preferences window

0K I Cancel Help

Display Scanner Status

Display Uniscan e4é status message: click this box to display a
Scanner Activated message at the top of the Windows desktop:

Show scan progress dialog when TWAIN is disabled: click this box to
display a scan progress window when the TWAIN box is disabled.

24



Using the Uniscan edB8 Utility - Preference Settings

| LCancel I

Temp Folder

This setting enables you to select the folder where image files are
stored. Seft this folder on a drive with sufficient disk space for large
image files. Click Clean temp folder files o delete the files in the
tfemp folder.

Smart scan Status

Show all applications for each scanner button: uncheck this box to
display only the applications that were assigned to the button when
you installed the software.

Holding scanner button activates Preferences window: if this box is
checked, pressing and holding any of the buttons on the scanner
will open the Uniscan e46 Utility Preference dialog box.

25



Scanning with TWAIN compliant applications - How to Initiate the
TWAIN interface

Scanning with TWAIN compliant applications

In addition to the included Prestol PageManager scanning software,
the scanner can also be used with any other application that
accepts scans via a standard link called TWAIN. Most major
scanning and image software programs operate using the TWAIN
interface, including MGI PhotoSuite, CorelDraw, IphotoPlus, Painter,
PhotoDeluxe, Photolmpact, PhotoShop, TextBridge, and many more.
This chapter discusses how to use the TWAIN interface in detail.

How to Initiate the TWAIN interface
After installing the scanner and associated software, you should be
able to find the scanner commands, as follows:

1. From within the TWAIN compliant application, choose Select
Source in the File menu to show the Select Source dialog box.
Select "Uniscan e46". Then click Select to close the dialog box.

select Source 2 x|
— WM sources

k. I Cancel

26



Scanning with TWAIN compliant applications - How to Initiate the TW

AN interface

2. Choose Acquire in the File menu, and the TWAIN window will

open:

LEEES

Reflective

Color 24 bit

200dpi

Mo Descreen

Custom

27



Scanning with TWAIN compliant applications - Scanning settings

Zoom

Drag MultiJob Setup

Help

Preview window

Message bar Crop
box
Preview Window

Click to initiate preview

Toggle Advanced/Primary
Mode

Reflective
Configuration
area

Calor 2
200dpi
Mo Descreen

Custom

I Auto Adjust

Exit TWAIN

Ll

k

Click to scan

After clicking the preview button, this window shows the document
or photo on the scanner glass. You can then view the effects made
by changes o the scan settings and define an area to scan: simply
drag your mouse to outline the area. You can adjust this area’s size
by dragging its handles, or its position by clicking on it and dragging.

At the top left of the window is a ruler type button; click this to

tfoggle the ruler units between inches, cm, and pixels.

Ruler Button

Clicking on the icon in the fop left corner of the preview window
allows you to toggle the ruler's measurement units from inches to

centimeters or pixels.

28



Scanning with TWAIN compliant applications - Scanning settings

crop

Selects the cropping tool. With this tool selected, click and drag with
the left mouse button in the preview window to define the area to
be scanned.

Drag

Selects the Drag tool. With this tool selected, click and drag with the
left mouse button to move the selection.

Zoom

Zoom in or out by clicking in the preview window.

Multilob

The Multijob function allows segmenting a scan image info multiple
sections, to oufput to multiple image files. This way, you can scan
different sections of the original image into several different output
files. For example, using Multijob, you can create a scan of the
entire picture and also each of the four quadrants of the image with
one pass of the scanner. The maximum number of mutlijobs is six.

setup

Opens the Setup dialog box. From this dialog box, you can
configure preset scanning icons for one-click scanning from the
Primary mode.

Help
Opens TWAIN online help.

Message bar

The message bar displays the predicted size of your scan, the
current units and the amount of free space on your hard disk. The
predicted size changes if you change the scan area size, scan
mode and/or resolution. If the image size exceeds the amount of
free space, you will not be able to complete the scan. In this case,
you can lower the scan mode, resolution or scan areaq, or create
more space on your hard disk.

Toggle Advanced/Primary Mode

Click the Advance/Primary button to switch between Advanced
and Primary modes.

Primary Mode

In Primary mode, you can click one of the five preset icons
to scan depending on your desired type of output.

29



Scanning with TWAIN compliant applications - Scanning settings

30

The five icons are: Scan Photograph, Scan Magazine, Scan
Data for OCR, Scan Photo for Web, and Custom.

Advanced Mode

In Advanced mode, you can set specific seftings for this
particular scanning instance. See Configuration Area,
below, for details.



Configuration area - General Settings

Reflective

Color 24 bit

200dpi

Mo Descreen

Cugtom

[ Auto Adjust

. [ Save | [ Load |  [Defaul |

General Settings provides the following general configuration
options:

Color Mode

Color Mode determines the amount of color information collected
from your original. Choose this opfion based on whether the original
is color or black & white, and on the purpose of your scanned
image (i.e., color display, black & white printing, OCR, etc.). Your
choice also influences file size; true-color creates the largest files,
while grayscale creates smaller files and black & white creates the
smallest. When you change this option, notice the projected file size
in the message bar: true-color images are three times larger than
grayscale and twenty-four fimes larger than black & white!

Color 48-Bit

Your scanner is capable of scanning images using 48-bit color depth.
This provides a more dynamic color and tonal range, giving your
scanned images a smoother and more colorful appearance.

The 48-bit color mode is disabled by default because currently only
a few application programs (such as Adobe PhotoShop) can
accept 48-bit image data. When disabled, your images will be
scanned in 24-bit color mode. To scan images in 48-bit color, simply

31



Configuration area - General Settings

enable 48-bit Color Mode in the Color Mode menu.
Color 24-Bit

This color mode collects a large amount of color information from
the original, up to around 16.7 million colors! Choose this option for a
color original that you want to display, print or edit in color.

Grey 16-Bit and Grey 8-Bit
Use either of these modes for black & white photos or for scanning

color material to print on a black & white printer. Choose 8-Bit for
lower quality and smaller file size black & white images.

B& W

Use this mode to scan text or line drawings - a picture or text
containing black lines only, with no colors or shades of gray.

Resolution

Resolution determines the amount of detail collected from an
original. The higher the resolution, the greater the detail. Select a
value based on the purpose of your scan. In general, we
recommend you keep the resolution as low as possible, because the
higher the resolution, the slower your scan and the larger the
resulting file size. Furthermore, a lower resolution (100-200dpi) when
using True Color or Greyscale can capture more color and detail
than most printers or monitors can show. When you adjust the
resolution, keep an eye on the projected file size in the message bar.
The following are suggested settings for various scan file types:

Document Type Resolution
Text (printed) 300
Text (fax) 200
Text for OCR 300

Black & White or greyscale image 150

Color photo orimage 150

100 dpi

For images o display on screen at about the same size as the
original in a presentation or on your web page. Also use this for
larger images that you will reduce in size to include in a report or
presentation and print out on a normal color or black & white printer

32



Configuration area - General Settings

(with a print resolution of 300~360dpi).
200 dpi

For small images to display at a larger size on screen, or for any
image to be printed out at original size on a color or black & white
printer (up to 720dpi print resolution). Also use 200dpi (with black &
white scan mode) for clear OCR text (larger than 10pt); for smaller
text, use 300dpi.

300 dpi

When quality is critical and a lower resolution is inadequate, choose
300dpi for any size image and for any use (fo determine if the
resolution is too low, look for squares in the image; see below). Also
use 300dpi (with black & white scan mode) for optimum OCR results.

Over 300 dpi

Unless you have a specific reason for selecting a higher resolution,
we suggest you do not, as the resulting file size may be very large
and take up a lot of your hard disk space. For example, a 3" x 5"
photograph scanned at 2400dpi, true-color will result in a file over
240MB in size.

33



Configuration area - General Settings

200dpi 200dpi 200dpi 200dpi
(enlarged 2x) (enlarged 3x) (enlarged 4x) (enlarged 8x)

300dpi 300dpi 300dpi 300dpi
(enlarged 2x) (enlarged 3x) (enlarged 4x) (enlarged 8x)

Note: When scanning an image that will result in a file size larger
than 25MB, a warning screen will appear giving you the
option to cancel.

Descreen

Descreen is used to reduce the effects of Moiré patterns. Although
not always obvious, Moiré patterns interfere with the quality of your
scanned image. Depending on their severity, they can appear as
waves or patterns superimposed over your image, or simply make
the image fuzzier. Moiré is a form of interference caused by the
imperfect alignment between pixels sent from the video card and
the screen. They appear in all color scan displays, and more often
affect scans of printed images than text, as well as scans at higher
resolutions as compared to those of lower resolutions.

Moiré patterns are an inevitable result of scanning, and will not be
completely eliminated untfil significant improvements in monitor
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fechnology can be made. If your scanned image is overlaid with a
ripple, wave, dot or other odd pattern, select Descreen and scan
again to remove this phenomenon and produce a cleaner image.

The scanner scanning in half tone pixels causes moiré, which the
screen is not able to display well. Descreen operates by replacing
half tone pixels with full tone pixels. Use higher levels of Moiré
Reduction for objects printed in Matt finish or on plain paper, while
lower levels can be used for originals such as gloss finish
photographs. A side effect of using the Descreen feature is a loss in
quality of the scanned image; try different settings until you find a
setting that gives the best compromise between quality and clarity.

Scan Size

Choose a Scan Size depending on the size of paper you wish to
output to (if output is fo be printed). You can also adjust scan size by
cropping the image in the preview window, which will set scan size
to Custom. You can move the area by dragging the box.

Auto Adjust

The auto adjust function is disabled by default. Select this option to
let the scanner automatically determine the size of the item being
scanned. When Auto Adjust is selected, the scanner makes two
passes. The first pass detects the item's size and the second pass
scans the item. To enable Auto Adjust, simply check the Auto Adjust
box in the general settings window.

Image Adjust is used to make specific alterations to the quality and
coloration of the output image. When you are satisfied with the
adjustments you have made, you can save the configuration for
later use by clicking Save and selecting a file name and directory.
Image Adjust contains 4 option screens: General Adjust, Curves,
Level and HSB.

General Adjust

General Adjust allows you to adjust the Brightness, Contrast, Gamma
and Sharpness of the output image.
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Brightness

Brightness is a measure, ranging from —100 to 100, of the relative
lightness or darkness of the image. Increasing the brightness will
bleach the scanning image, while decreasing it will result in a darker
final image. Move the slider to adjust the brightness of the overall
image or the selected color.

Contrast

The higher the Contrast, the clearer the image, while lower Contrast
results in blurry images. Increasing the Confrast decreases the mid-
range hues, and increases the high and low hues. Generally,
adjusting Contrast is used to eliminate spots and shadows from
scanned black & white or greyscale images, or to "clean" color
images. Move the slider to adjust the Contrast of the overallimage
or the selected color. This function is not suitable for line drawings or
other pure black & white images.

Gamma

Moving the Gamma slider will affect the colors in your image as
seen on the monitor. Although the default Gamma setting is ideal
for most scans, the computer does not always receive the precise
color information from the scanning hardware, and some distortion
in color may occur. Through altering the gamma of either the overall
image or the selected color, you can achieve the exact coloration
you desire.

Sharpness
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Move the slider o make the image sharper or fuzzier.

curves

Select Curves to display the red, green, or blue color curve. The
mixed color will be displayed in black.

-] ] (] @] ree -

Input B3 |

Output

=

| Load | | Default |

B e

Note: changing the color curve will affect the results of all scanner
output.

Llevel

Level displays a histogram of the distribution of red, green, blue,
grayscale, hue, saturation, and/or lightness values in an image. The
horizontal axis represents the lightness values of the image from
black to white (0 fo 255). The vertical axis indicates the number of
pixels af each value. At a lightness level where there are many pixels
of one of the values, the corresponding line spikes; where there are
few pixels, it appears close to the horizontal axis. In dark images,
most of the pixels are grouped at the left side. If an image is too light,
the pixels are grouped at the right.
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Saturation is the intensity or purity of the colors displayed in the
image. The intensity of the color refers to the color's distance from
the shade of gray; a value of —100 represents gray, while a value of
100 represents the most intfense color.

Hue indicates a color's position on the standard color wheel. At a
value of 0, the colors stay true to the original image. Changing hue
rotates the color's position by the appropriate number of degrees
along the color wheel. For example, selecting a hue value of =30
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rotates the color's position 30 degrees, while a hue value of 30
represents a clockwise rotation of 30 degrees. Obviously, the
greatest hue values are —180 and 180, which changes all the
image's colors to the exact opposite colors according to the color
wheel.

Brightness is a measure, ranging from =100 to 100, of the relative
lightness or darkness of the image. Increasing the brightness will
bleach the scanning image, while decreasing it will result in a darker
final image. Move the slider to adjust the brightness of the overall
image or the selected color.

Tips for correcting scanned images

The above options are for advanced users and users already familiar
with image editing tools. We strongly recommend that beginners do
not use these tools until they have become familiar with the scanner
and the technical terminology related to image creation. Many
image editing software applications also include these functions. If
you must adjust image color levels, please choose the appropriate
options before you begin adjusting. Below are a few practical tips
for your reference.

Also known as tone correction commands, these settings adjust
images as they are scanned. For example, you may have a photo
that is over-exposed (too light); you can thus decrease the
brightness or color correction to darken the photo. Confrast makes
the difference between dark and light areas more or less obvious.
Increasing it increases the difference, while decreasing it reduces
the difference. Try small changes at first and view the effect.
Experimentation is the best route to good results. However, for most
photos and documents, you will not need to adjust these values.

The color correction control also allows you to adjust the gamma. If
you have an "off-color” original, for example one in which skin fones
are a little green, fry reducing green gamma and/or increasing red
gamma. Gamma may be adjusted either by increasing/reducing
the gamma of the color, or by reducing/increasing its
complementary colors.

After previewing your scan, changes made to these settings are
reflected in the preview window. Making changes in this way allows
you to experiment without having to scan again to check the results
every time.
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Hint: look at the gray strip on the right
i

Contrast -25 Contrast +25
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Scanning night shots*

If you have particularly dark photos (that are correctly exposed) fry
increasing the gamma a littfle (maybe up o 1.4) to bring out details in
the shadowed areas without affecting the overall tonal range in the
image.

Scanning snow shots*

For very light photos, for example from a skiing frip in bright sunlight,
reduce the gamma (maybe down to 0.8) to bring out details in the
bright areas. This again does not affect the overall tonal range in the
image.

» If you use brightness or contrast in the above two cases, you
actually reduce the amount of information collected from the
original, while gamma collects more information in the darker or
lighter areas, and less in the opposite type of area.

Scanning text for OCR

If your OCR result is not safisfactory, it may be because the original is

unclear. First, adjust the brightness. Try =10 for bolder text, for lighter, fry

+10. With this you can increase the contrast slightly for bolder text or
decrease the contrast for lighter text.

Scanning line art drawings

If parts of lines fade out after scanning, you can reduce the brightness
and/or decrease the contrast in much the same way as for scanning
text. Similarly, if you find that scanned lines appear bolder (fatter),
reduce the brightness and/or increase the contrast.
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Troubhleshooting

This section provides information on maintaining the scanner and
answers questions to help you solve problems you might encounter
when using it. If you continue to experience problems, or if the
problem is not covered in this guide, please contact your local dealer.

Scanner does not respond.

»  Make sure all connections are secure and correct.

» Restart the computer and try again.

»  Reinstall the software, restart your computer and then try again.
>

Check that the Universal Serial Bus of your computer is Enabled.
This setting (Universal Serial Bus Controller) can be found under
the System option in your Control Panel in the Device Manager (if
in doubft, check Windows Help).

Problems during installation

Setup wizard does not aulostart.

» Check your computer system to see if Autostart is available.

» Under Windows, check if your CD-ROM is set to Auto Insert
Notification. This setting can be found under the System option in
your Control Panel in the properties of your particular CD-ROM
model (if in doubt, check Windows Help).

Cannot find program icons after restarting the computer.

» If program icons do not appear in the Start menu under Programs,
fry reinstalling.

Selup wizard crashes during installation.

» Reinstall the software.

The scanner's scanning lamp does not light up.

»  Make sure the TWAIN window appears on screen. If not, reselect
the TWAIN source and activate the TWAIN interface again.

»  Make sure all connections are secure and correct.
Scanner scans very slowly.

» Make sure the resolution of the scanner is not set too high
(preferably 300 dpi or lower).
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»  Check your connections (see Problems with connections above).

Error: Scanner not found.

Displayed if there is a problem communicating with the scanner. This
may be caused by a power outage, misconnection or an installation
problem. First check your connections and check that your wall
socket and power switches are all turned on. Next check the
following:

(1) USB setting is enabled. (2) Power adapter is plugged into the
scanner connector. (3) USB cable is properly connected from the
scanner to your PC.

Prohlems in TWAIN

The TWAIN window does net appear after choosing Acquire.
» Make sure all connections are secure and correct.

» Check that the scanner is selected in the Select Source dialog
box.

» Reinstall the software.
»  Check your connections (see Problems with connections above).

Unable to scan to application software.

» Check that the scanner is selected in the Select Source dialog
box.

» Make sure all connections are secure and correct.

» Close all open programs and Windows, restart your computer
and fry again.
Prohlems with the scan

The scanned image is too light or too dark.

» Checkif the Scan Window is clean.

»  Adjust the brightness or color gamma settings and try again.
Moiré patterns appear on the scanned image.

» The original image is commercially printed. Try reducing the
resolution by a small amount, for example from 200 dpi to 190 dpi;
keep reducing unftil the patterns disappear. Or you may check
Descreen under the Advanced tab in the TWAIN interface.

Transitions in color are very abrupt (after scanning in irue color
mode).
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Configuration area - Problerms with the scan

This is normal if you are using a display mode that can only
display 256 or 16 colors. Try using a high- or true-color mode
instead. Refer to the Windows Manual and your display card
guide for more information.
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